DOWNLOAD PDF ELECTRONIC SIGNATURE ON
Chapter 1 : What are electronic signatures, e-signatures | Adobe Sign
Start your free trial to place electronic signatures anywhere on a PDF document or form with Adobe Acrobat DC. Close
deals faster with e-signatures.

Based on the intent, you use different types of signatures. This document provides instructions for Acrobat DC
and Acrobat Sign an agreement If someone has used Adobe Sign to send you an agreement for signing, you
receive an email notification with a link to sign the agreement. Also, if you use Acrobat DC or Acrobat Reader
DC desktop application, you see a notification that an agreement has been shared with you for signing. Do one
of the following to sign an agreement sent to you using Adobe Sign: Sign using the email link Click the link of
the agreement received in your email for signing. The agreement opens in web browser. Click in the fields and
enter any requested information. Image- Browse and select an image of your signature. All the agreements
shared or received for signature are displayed. Double-click the agreement with the Waiting For You status, or
select the agreement, and click Sign in the right-pane. Click the signature field. Click Click To Sign. You can
also add text, such as your name, company, title, or the date. When you save the document, the signature and
text become part of the PDF. For more information, see Capture your signature on mobile and use it
everywhere. To add text, such as your name, company, title, or date, drag and drop your personal saved
information from the right pane onto a form field. Alternatively, you can use Add Text in the toolbar. Click at
the place in your document where you want to add the text, and start typing. Use the field toolbar to make
appropriate changes. Click the Sign icon in the toolbar, and then choose whether you want to add your
signature or just initials. If you have already added signatures or initials, they are displayed as options to
choose from. Skip to the next step. Below is an example of the Signature panel. You can choose to type, draw,
or import a signature image. Added signatures and initials are saved for future use. Type your name in the
field. Browse and select an image of your signature. Draw your signature in the field. Click Apply, and then
click at the place in the PDF where you want to place the signature or initial. To move the placed signature or
initial, click the field to highlight it and then use the arrow keys. To resize or delete the field, use the options
in field toolbar. If you want to use an image as your signature: Sign your name in black ink on a clean, blank
sheet of white paper. Photograph or scan your signature. If you are taking a picture of your signature, make
sure that the page is lit and that no shadows fall across the signature. Transfer the photo or scan to your
computer. You do not need to crop the image. Send your signed PDFs After you have signed the form, you
can share it with others. It lets signers quickly sign agreements from anywhere using a web browser or mobile
device. Signers are not required to sign up or purchase any Adobe product to sign the agreements. The Send
for Signature tool also helps you track the entire signing process. The tool sends an email to your signers
asking them to sign an agreement. Once signed, both you and your signers receive the signed PDF by email.
For more information, see Send PDF documents for signature.
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Chapter 2 : 3 Simple Ways to Insert a Digital Signature in a Word Document
This is where an electronic signature, which is a virtual representation of your John Hancock, comes in handy. You don't
need any fancy or expensive software to create a digital signature. All a Windows user needs is Paint, the graphics
program that is included with the OS.

A digital signature is an electronic, encrypted, stamp of authentication on digital information such as e-mail
messages, macros, or electronic documents. A signature confirms that the information originated from the
signer and has not been altered. When you send a digitally-signed macro or document, you also send your
certificate and public key. A certificate is usually valid for a year, after which, the signer must renew, or get a
new, a signing certificate to establish identity. You can learn more about public and private keys in this article.
It issues digital certificates, signs certificates to verify their validity and tracks which certificates have been
revoked or have expired. For more information on obtaining a digital certificate see Obtain a digital certificate
and create a digital signature. What does a digital signature guarantee? Repudiation refers to the act of a signer
denying any association with the signed content. To make these assurances, the content creator must digitally
sign the content by using a signature that satisfies the following criteria: The digital signature is valid. The
certificate associated with the digital signature is current not expired. The signing person or organization,
known as the publisher, is trusted. Signed documents, which have a valid time stamp, are considered to have
valid signatures, regardless of the age, or revocation status, of the signing certificate. The certificate associated
with the digital signature is issued to the signing publisher by a reputable certificate authority CA. Top of Page
Signature lines in Word and Excel A signature line resembles a typical signature placeholder that might appear
in a printed document. However, it works differently. When a signature line is inserted into an Office file, the
author can specify information about the intended signer, and instructions for the signer. When an electronic
copy of the file is sent to the intended signer, this person sees the signature line and a notification that their
signature is requested. A digitally-signed document becomes read-only to prevent modifications. Create a
signature line in Word or Excel In the document or worksheet, place your pointer where you want to create a
signature line. In the Signature Setup dialog box, type information that will appear beneath the signature line:
To add additional signature lines, repeat these steps. If the document remains unsigned, the Signatures
Message Bar appears. Click View Signatures to complete the signature process. Top of Page Sign the
signature line in Word or Excel When you sign a signature line, you add a visible representation of your
signature and a digital signature. In the file, right-click the signature line. If the file opens in Protected View,
click Edit Anyway, if the file is from a reliable source. From the menu, select Sign. To add a printed version
of your signature, type your name in the box next to the X. To select an image of your written signature, click
Select Image. In the Select Signature Image dialog box, find the location of your signature image file, select
the file that you want, and then click Select. In addition, you can sign a signature line by double-clicking the
signature line. Type your name next to the X. Or, in the Signature Pane, in the Requested Signatures section,
click the arrow next to the signature. To add a handwritten signature Tablet PC users only , sign your name in
the box next to the X by using the inking feature. The Signatures button appears at the bottom of the document
or worksheet. The following image shows the Signatures button. Remove digital signatures from Word or
Excel Open the document or worksheet that contains the visible signature you want to remove. Right-click the
signature line. In addition, you can remove a signature by clicking the arrow next to the signature in the
Signature Pane. Top of Page Invisible digital signatures in Word, Excel, or PowerPoint An invisible digital
signature, such as a visible digital signature line, assures the authenticity, integrity, and origin of a document.
You can add invisible digital signatures to Word documents, Excel workbooks, and PowerPoint presentations.
Signed documents will have the Signatures button at the bottom of the document. In addition, for signed
documents, signature information appears in the Info section that you see after you click the File tab. Signed
documents have the Signatures button at the bottom of the document. Click the File tab. Click Add a Digital
Signature. In the Sign dialog box, in the Purpose for signing this document box, type the purpose. After a file
is digitally signed, the Signatures button appears, and the file becomes read-only to prevent modifications.
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Remove invisible digital signatures from Word, Excel, or PowerPoint Open the document, worksheet, or
presentation that contains the invisible signature you want to remove.
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Chapter 3 : Online Signature: Digital Signature & Sign Documents Online
You can add signatures to documents and email messages in a few steps. Signatures in email messages support your
identity, your logo, or www.nxgvision.coml signatures confirm the authenticity of your macros, legal documents, and
other electronic documents, such as emails, or code projects, which you want to send or distribute.

Description[ edit ] An electronic signature is intended to provide a secure and accurate identification method
for the signatory to provide a seamless transaction. Definitions of electronic signatures vary depending on the
applicable jurisdiction. A common denominator in most countries is the level of an advanced electronic
signature requiring that: The signatory can be uniquely identified and linked to the signature The signatory
must have sole control of the private key that was used to create the electronic signature The signature must be
capable of identifying if its accompanying data has been tampered with after the message was signed In the
event that the accompanying data has been changed, the signature must be invalidated [7] Electronic
signatures may be created with increasing levels of security, with each having its own set of requirements and
means of creation on various levels that prove the validity of the signature. To provide an even stronger
probative value than the above described advanced electronic signature, some countries like the European
Union or Switzerland introduced the qualified electronic signature. It is difficult to challenge the authorship of
a statement signed with a qualified electronic signature - the statement is non-reputable. Some of these
messages were agreements to terms that were intended as enforceable contracts. An early acceptance of the
enforceability of telegraphic messages as electronic signatures came from the New Hampshire Supreme Court
in Although the original signature on the original document was on paper, the image of the signature and its
transmission was electronic. Canadian law PIPEDA attempts to clarify the situation by first defining a generic
electronic signature as "a signature that consists of one or more letters, characters, numbers or other symbols
in digital form incorporated in, attached to or associated with an electronic document", then defining a secure
electronic signature as an electronic signature with specific properties. However it will reach a higher
probative value when enhanced to the level of a qualified electronic signature. By requiring the use of a
qualified electronic signature creation device [19] and being based on a certificate that has been issued by a
qualified trust service provider, the upgraded advanced signature then carries according to Article 25 2 of the
eIDAS Regulation the same legal value as a handwritten signature. A qualified electronic signature is not
defined in the United States. Code defines an electronic signature for the purpose of US law as "an electronic
sound, symbol, or process, attached to or logically associated with a contract or other record and executed or
adopted by a person with the intent to sign the record. Under UETA, the term means "an electronic sound,
symbol, or process, attached to or logically associated with a record and executed or adopted by a person with
the intent to sign the record. ESign Act of The intent is to ensure the validity and legal effect of contracts
entered into electronically. For instance, PIPEDA Canadian federal law 1 An electronic signature is "a
signature that consists of one or more letters, characters, numbers or other symbols in digital form
incorporated in, attached to or associated with an electronic document"; 2 A secure electronic signature is as
an electronic signature that a is unique to the person making the signature; b the technology or process used to
make the signature is under the sole control of the person making the signature; c the technology or process
can be used to identify the person using the technology or process; and d the electronic signature can be linked
with an electronic document in such a way that it can be used to determine whether the electronic document
has been changed since the electronic signature was incorporated in, attached to or associated with the
electronic document. UETA Sec 2 US state law 5 "Electronic" means relating to technology having electrical,
digital, magnetic, wireless, optical, electromagnetic, or similar capabilities. An S-signature is a signature
inserted between forward slash marks, but not a handwritten signature A Presented in printed or typed form
preferably immediately below or adjacent the S-signature, and B Reasonably specific enough so that the
identity of the signer can be readily recognized.
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Chapter 4 : Signing PDFs in Adobe Acrobat
DocuSign is the global leader in electronic signature with hundreds of millions of users in more than countries worldwide.
Send a document from Paris, sign it in Tokyo, and close business in minutes.

An electronic signature, or e-signature, is a legal way to get consent or approval on electronic documents or
forms. One of the most relied upon definitions of an electronic signature defines an electronic signature as:
Examples include contracts, application forms, new hire onboarding forms, non-disclosure agreements, vendor
onboarding and RFPs, change authorizations, and government benefits enrollment forms. Electronic signatures
are legally valid and enforceable in nearly every industrialized country around the world, and even
less-developed countries are beginning to enact e-signature laws. Other countries have enacted similar laws as
well. To learn more, visit our Electronic Signatures are Legal page. Adobe takes the security of your digital
signing experiences very seriously. Adobe Sign also employs Adobe Secure Product Lifecycle SPLC
practices, a demanding set of over 1, specific security activities spanning software development practices,
processes and tools, integrated into multiple stages of the product lifecycle. Whether related to identity
management, data confidentiality, or document integrity, Adobe Sign protects your documents, data, and
personal information. To learn more, please visit the Adobe Trust Center. Are digital signatures the same as
electronic signatures? Electronic signatures, or e-signatures, refer broadly to any electronic process that
indicates acceptance of an agreement or a record. The term digital signature is frequently used to refer to one
specific type of electronic signature. Typical e-signature solutions use common electronic authentication
methods to verify signer identity, such as email, corporate IDs, or a phone PIN. Multifactor authentication is
used when increased security is needed. The best e-signature solutions demonstrate proof of signing using a
secure process that includes an audit trail along with the final document. Digital signatures use a specific type
of electronic signature. They use a certificate-based digital ID to authenticate signer identity and demonstrate
proof of signing by binding each signature to the document with encryption â€” validation is done through
trusted certificate authorities CAs or Trust Service Providers TSPs. Signature types are linked with signature
laws and regulatory requirements. How do I create an electronic signature? With Adobe Sign, recipients can
electronically sign documents by typing or drawing their name on their computer or mobile device, or
uploading an image of their signature. They can also use more advanced digital signatures that rely on
certificate-based digital IDs to provide stronger signer authentication. What document formats does Adobe
Sign support for e-signatures? Adobe Sign lets you upload a wide range of documents types when you request
signatures from others or build reusable templates. They include the following:
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Chapter 5 : Electronic signatures - Microsoft Office
A digital signature is an electronic, encrypted, stamp of authentication on digital information such as e-mail messages,
macros, or electronic documents. A signature confirms that the information originated from the signer and has not been
altered.

The Standard Edition of Document Cloud, a subscription service, delivers solid tools to create, edit, sign, and
export PDF documents to desktop and mobile devices. SkySignature SkySignature is a web-based digital
signature service that includes many extra features. Bottom Line SkySignature is a digital signature service
that features state-of-the-art security at the user and the data levels. SkySignature is also fully mobile
compatible, so users can sign or request signatures on the fly. SignEasy SignEasy is a mobile tool for
obtaining document signatures electronically. Bottom Line SignEasy is a cloud-based tool that allows users to
send documents to a mobile device to view, read, complete, and affix an official signature. The signed and
completed documents can be returned to the source and saved on other mobile devices or desktop computers.
Signatures obtained with SignEasy are legally binding. Secured Signing Secured Signing is a digital signature
solution that allows users to sign documents online. Bottom Line A cloud-based signature solution, Secured
Signing allows users to securely sign or invite others to fill-in and sign documents of all types online from any
computer, smartphone, or tablet. All collected signatures meet legal requirements for proper document
signing. A highly secure digital e-signature solution for all document types. Bottom Line RightSignature is an
e-signature solution that provides businesses with an easy, intuitive way to get documents signed fast. With no
additional installation, downloads, or special equipment needed, businesses can securely implement electronic
signatures in their management procedures from any browser, computer, or email account. Bottom Line
PDCflow enables business and online sellers to accept payments and collect digital signatures. Its workflow is
designed for both single and recurring transactions, which makes it ideal for any size business. PandaDoc
Improve sales with PandaDoc document management. Bottom Line PandaDoc offers several features that
create and process documents for salespeople, including auto-fill. When documents are complete, PandaDoc
sends them to the people who are required to approve them. Adobe Sign Adobe Sign services simplifies the
collection of required signatures on documents. Bottom Line Adobe Sign services helps you manage the flow
of documents that require signatures and collects those signatures electronically. It offers a variety of
integrations and features for flexibility and strong workflow management. Legalesign Legalesign is an
electronic signing software for contracts and forms. Bottom Line Legalesign was designed for companies and
businesses that want to generate contracts and forms and make them available for digital signatures.
Legalesign is easy to use and requires little to no training to implement, making it ideal for nearly every type
of organization. Inkdit Inkdit is an e-signature software application for forms and contracts. Bottom Line
Inkdit is a software application designed to capture digital signatures for forms or contracts where a legal
signature is required. Inkdit can also convert PDF forms into useable and easy form fields, which can be used
on a mobile device to increase the usability and portability of the software. Complete and sign digital
documents with legally binding signatures. Bottom Line IdenTrust Trust Sign is an electronic document
signature solution that enables you to complete, sign, and deliver digital documents securely and privately
over the Internet. Document integrity and authenticity are ensured by Trust Sign, and the electronic signatures
are legally binding. Sign contracts and other documents electronically with legally binding signatures. Bottom
Line HelloSign enables you and others to sign contracts and other legal documents with a legally binding
electronic signature. Eliminate the inconvenience of having to print, sign, fax or scan and email , and then file
a paper document. Simply sign electronically and send online whenever and from wherever necessary.
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Chapter 6 : How to Create an Electronic Signature in Microsoft | It Still Works
An electronic signature, or e-signature, refers to data in electronic form, which is logically associated with other data in
electronic form and which is used by the signatory to sign.

Share on Facebook As more corporate communications switch from paper to paperless, you may find yourself
struggling to find a way to verify electronic documents. This is where an electronic signature, which is a
virtual representation of your John Hancock, comes in handy. All a Windows user needs is Paint, the graphics
program that is included with the OS. Creating an electronic signature is incredibly similar to writing a
signature on paper. Step To open Paint, click the Start button, navigate to the "Accessories" folder, and choose
"Paint" or press the Windows key, type "mspaint. Click the small down-pointing arrow in the top-left corner
and select "Properties. The height of the space should be longer than its width, but leave enough room to
"write" the actual signature. A width of two inches and height of four inches should suffice. Make sure the
"Inches" radio button is selected, and then click the "OK" button. Step Click the "Brushes" button on the
ribbon in Windows 7 and choose "Caligraphy brush 1" from the drop-down menu. In earlier versions of
Windows, the Brushes options are located on the main Paint menu. Video of the Day Step Click the "Size"
button on the ribbon and select the thinnest line option at the top of the drop-down menu. Step Review the
color choices on the ribbon. For a black electronic signature, leave the Paint default. Otherwise, click a small
colored square and note the color changes in the "Color 1" box on the ribbon. Step Move the cursor near the
left edge of the white Paint workspace. Press and hold the left mouse button. Draw your first name just as you
would if you were using a pen. Keep an eye on the parameters of the Paint workspace. Step Click the small
down arrow again and choose "Save as.
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Chapter 7 : Electronic signatures, online e-signatures | Adobe Acrobat DC
Electronic signatures are legally valid and enforceable in nearly every industrialized country around the world, and even
less-developed countries are beginning to enact e-signature laws. In , the United States passed the ESIGN Act, making
e-signatures legal for virtually all uses.

When you set up an electronic signature in Microsoft Outlook or Word, it automatically appears at the bottom
of each message you send. There are many ways to customize your signature such as adding quotes, contact
information, mission statements and pictures. You can even designate different signatures for different email
groups, such as personal and business. Electronic signatures are easy to create and manage. Create Your
Message Decide on an overall tone, or voice, for your electronic signature based on your general audience.
Proofread your written content, test hyperlinks, and double check email addresses and phone numbers. Choose
"Options" from the menu. Select "Mail Format" third tab from the left , and click on the "Signatures" radio
button at the bottom right of the menu. Enter a name for your signature so you can easily recognize it later,
and click on the "Next" arrow. Type your signature message. Customize it by using the formatting options at
the bottom of the window. You may also import a v-card from your "Contacts" menu. Click "OK" to save
your signature. Click on "Tools" on the top left side of your screen. From the "Options" menu, select the
"Signatures" option. Click the "New" button, and type in your signature. If you want this signature to
auto-populate in all of your e-mails, click on "add signatures to all outgoing messages. Tip Avoid lengthy
signatures, as they may distract the reader from the actual message of the email. Large graphics can be a drain
on computer resources, and may cause problems for the recipient. She has been a human resources
professional for more than 15 years, specializing in employee relations, resume preparation and interview
training. After several years of writing materials related to her profession, she began writing professionally.
Chapter 8 : How to Create a Free Electronic Signature | www.nxgvision.com
This wikiHow teaches you how to insert a digital signature into a Microsoft Word document by using the DocuSign
add-in, as well as by using the built-in Signature Line tool in Microsoft Word on Windows or by converting it to a PDF file
and adding a signature in the Preview app on Mac.

Chapter 9 : Top Electronic Signature Software for - www.nxgvision.com - PCMag
Advanced Electronic Signatures (AES) and Qualified Electronic Signatures (QES) are fully supported in SigningHub.
AES and QES provide the highest level of trust and assurance because these use unique signing keys for every signer.
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